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INTRODUCTION

Light sheet fluorescence microscopy (LSFM)



with a low-magnification objective mounted in the epifluorescence port of the inverted 

microscope, and it is translated to the focus of each objective. This geometry is well adapted 

for imaging cultured cells and horizontally mounted tissues, avoiding the difficulty of 

mounting such samples in a vertical sample holder17. More recently, we modified iSPIM to 

capture a second specimen view, by alternating excitation and detection between the two 

objectives. The resulting ‘diSPIM’ provides isotropic spatial resolution (down to 330 nm) at 

high speed (200 images per s, 0.5 s for a dual-view 50-plane volume)11.

Overview of the procedure

Here we describe the step-by-step construction of a diSPIM entirely from commercially 

available parts (Fig. 1). Unlike our previous implementation11, which used free-space optics 

to couple in laser excitation to the sample, this design is compatible with fiber-coupled laser 

excitation. Such fiber-based excitation facilitates alignment, making the device compatible 

with a broad array of commercial laser excitation sources, and it assures collinearity among 

different excitation wavelengths. Furthermore, instead of controlling multiple galvanometric 

mirrors, compact scan-heads (one for each specimen view) are used to generate and sweep 

the excitation sheets through the sample, also aiding in system alignment. Data acquisition 

software for generating and sweeping the light sheets, controlling and synchronizing 

objective piezos, and recording images from scientific complementary metal-oxide 

semiconductor (sCMOS) cameras is also provided.

After describing diSPIM construction, we present controls for verifying the spatial 

resolution of the system and the proper alignment of the light sheets. Next, we describe the 

use of diSPIM in performing 3D imaging of C. elegans embryos throughout 14 h of 

development, and imaging of whole cells over ~30 min. The same protocol can be adapted 

for 4D studies of other samples of approximately similar dimensions (50 × 50 × 50 μm3). 

We conclude with the postprocessing (registration and image fusion and deconvolution) 

operations necessary to produce data sets with isotropic resolution.



Limitations

To obtain the best diSPIM data, it is necessary to obtain high-quality specimen views from 

each objective lens. Furthermore, the objectives must provide faithful but complementary 

measurements of the same object. If the object moves during dual-view acquisition (motion 

blur), if one view provides noticeably inferior image quality (owing to depth-dependent 

scattering or aberrations that preferentially degrade that view), or if the two views are poorly 

aligned, the fused reconstruction may display artifacts (Supplementary Note 1, SF1 and 

Supplementary Data 1). In extreme cases, the registration algorithm may be unable to 

correctly align the two views owing to a low degree of similarity between the views. 

Although we prefer dual-view acquisition owing to the isotropic resolution it provides, we 

note that single-view operation (iSPIM5) is at least twice as fast and may be preferred if 

acquisition speed is of paramount importance. Single-view operation also obviates imaging 

artifacts that arise because of the registration or fusion process, and it is fully compatible 

with this protocol.

We have enjoyed the most success when imaging small (~50–60 μm), transparent samples 

(single cells, a few layers of cells or C. elegans embryos; Supplementary Videos 1 and 2), 

wherein the 3D dynamics of interest occur no faster than several volumes per s. Larger 

samples may be accommodated by using lower- magnification objectives (10× or 20× 

lenses) and/or by widening the width of the light sheet (by further stopping down the iris)—

although we do not cover this explicitly in this protocol, our design is flexible enough to 

accommodate such changes (Supplementary Table 1). For especially large, scattering 

samples (such as D. melanogaster embryos), two-photon excitation may provide better 

performance than conventional single-photon excitation18. In this case, modifications to our 

system might include fibers appropriate for the high pulsed intensities generated by 

femtosecond laser sources, optical components that are better adapted for near-IR 

wavelengths and alternate methods of shuttering or modulating the beam intensity. 

Implementing confocal slit detection19 in each arm would also reduce background in 

scattering samples. Finally, we note that alternative LSFM implementations that use 

bidirectional illumination18 and detection7,8 may offer better sample coverage in large 

specimens than the implementation we describe here.

Experimental design

Fiber-coupled laser excitation—The laser excitation in this design is coupled to the 

diSPIM module by two optical fibers, one for each arm of the microscope. Many 

commercial options exist for single-mode fiber-coupled laser excitation (for example, the 

Nikon MLC 400B), providing compact assemblies with a range of wavelengths and powers 

(~10 mW per laser line at the output of each fiber is more than sufficient for most 

fluorescent samples). If you are obtaining a commercial solution, the two requirements are: 

(i) the end of the fiber should have an FC/PC (or FC/APC) connector, for coupling into the 

diSPIM excitation scanner; and (ii) it should be capable of rapidly modulating the power and 

switch between laser lines at high speed (ms or faster).

A cheaper, but potentially more time-consuming, option is to construct your own laser 

launch from component parts. Although the step-by-step construction of such an assembly is 
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outside the scope of this paper, we provide a schematic and photograph of our custom-built 

diSPIM launch (Supplementary Note 1, SF2). In this setup, we use an acoustooptic tunable 

filter (AOTF) to modulate 488-nm (for exciting GFP and similar fluorophores) and 561-nm 

(for exciting mCherry and similar fluorophores) laser wavelengths, combining the two lines 

before splitting the beams into two optical fibers. The maximum power at the fiber output 

(before insertion into the diSPIM scanners) in this design is 20 mW (488-nm excitation) and 

10 mW (561-nm excitation).

Microscope hardware—



http://www.wormguides.org/dispim/dispim-downloads
http://www.wormguides.org/dispim/dispim-downloads
http://mipav.cit.nih.gov/


MATERIALS

REAGENTS

For verifying diSPIM alignment and system performance

• Alexa Fluor 488 fluorescent streptavidin (Invitrogen, cat. no. S-32354)

• Yellow-green fluorescent beads, 100 nm (Invitrogen, cat. no. F8803)

For C. elegans embryo imaging

• Gravid young adult C. elegans, strain BV24 [ltIs44 [pie-1p-mCherry:: 

PH(PLC1delta1) + unc-119(+)]; zuIs178 [(his-72 1 kb::HIS-72::GFP); unc-119(+)] 

V], as described in Wu et al.5

• Poly-L-lysine (Sigma-Aldrich, cat. no. P1524)

• Methyl cellulose (Sigma-Aldrich, cat. no. H7509-25G)

• M9 buffer, see Stiernagle21

For cellular imaging

• DMEM with high glucose (4.5 g/l), supplemented with GlutaMAX and sodium 

pyruvate (Life Sciences, cat. no. 10569-069)

• DMEM without glucose, glutamine, pyruvate and phenol red (Life Technologies, 

cat. no. A14430-01)

• Glucose solution, 45% (wt/vol) (Corning, cat. no. 25-037-CI)

• Sodium pyruvate, 100 mM (Life Technologies, cat. no. 11360088)

• GlutaMAX supplement (Life Technologies, cat. no. 35050061)

• Sodium bicarbonate, 7.5% (wt/vol) solution (Life Technologies, cat. no. 25080094)

• HyClone FBS, defined (Thermo Scientific, cat. no. SH30070.03)

• HEPES 1 M sterile-filtered solution, pH 7.0–7.6 (Sigma, cat. no. H0887)

• TurboFect transfection reagent (Thermo Scientific, cat. no. R0531)

• Tissue culture dish, 100 mm, BD PureCoat amine (BD, cat. no. 354732)

• Hydrochloric acid (HCl), 37% (wt/vol) solution (Sigma, cat. no. 320331)

• Ethanol, 99.5% (vol/vol; Sigma, cat. no. 459844)

• GFP-tagged H-Ras plasmid22 (GenBank accession no. AF493916)

• Transformed human lung fibroblasts22

• Glass coverslips, no. 1.5, 24 × 50 mm (VWR International, cat. no. 48393-241)
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EQUIPMENT

For diSPIM system

• DiSPIM acquisition and data processing computer workstation (HP, cat. no. Z820 

with features and accessories described in Supplementary Table 2). This computer 

should also include a solid-state RAID drive, with specifications equivalent or 

similar to the following: Corsair Neutron Series GTX, solid state drive—240 GB— 



quantity 4, clamping fork for 1.5-inch post, cat. no. PF-175; quantity 2, 1/2-inch 

diameter (length 4 inches) post holder, cat. no. PH4; quantity 4, 1/2-inch diameter 

(length 4 inches) stainless steel optical post, cat. no. TR4)

• Optical table with isolators, 4 feet × 6 feet × 12 inches (TMC, cat. nos. 

784-651-02DR and 14-416-34)

• Metric and imperial ball-drivers and hex keys for bolting and unbolting 

optomechanical components (Thorlabs, cat. nos. TC2, TC3/M)

For testing equipment

•

http://joule.ni.com/nidu/cds/view/p/id/3802/lang/en
http://joule.ni.com/nidu/cds/view/p/id/3802/lang/en
http://dcam-api.com/downloads/
http://dcam-api.com/downloads/
http://dcam-api.com/hamamatsu-software/
http://www.asiimaging.com/support/downloads/ms-2000-control-using-nis-labview-and-the-serial-port/
http://www.asiimaging.com/support/downloads/ms-2000-control-using-nis-labview-and-the-serial-port/
http://rsbweb.nih.gov/ij/
http://mipav.cit.nih.gov/


• Dissecting microscope with 10×–50× zoom range and fluorescence capability (for 

example, Leica, cat. no. MZ10F)

• Platinum wire, 0.5-mm diameter (Sigma-Aldrich, cat. no. 267201)

• Pasteur pipette (Corning/Sigma-Aldrich, cat. no. CLS7095D5X)

REAGENT SETUP

M9 buffer—M9 buffer for imaging worm embryos is prepared as described in Stiernagle21. 

M9 buffer can be stored at 23 °C for 6–8 weeks.

Poly-L-lysine—Poly-L-lysine is used for sticking the embryos to glass coverslips. We use 

a working concentration of 1 mg/ml Poly-L-lysine dissolved in Milli-Q or similarly clean 

water. For long-term storage, prepare 5–10-ml aliquots and store them at −20 °C. Once 

thawed, the aliquots can be stored at room temperature (23 °C) indefinitely.

Methyl cellulose—Methyl cellulose is used for cutting the worms in order to release the 

embryos. Prepare a 1% (wt/vol) solution in M9 buffer (we usually prepare 50-ml batches 

containing 0.5 g of methyl cellulose). Methyl cellulose must be stirred in warm M9 until it is 

dissolved. Once prepared, this solution can be stored at room temperature for up to 6 

months.

Preparation of coverslips with fluorescent bead layer—Fluorescent beads are 

convenient resolution targets, and they are useful in aligning and testing the diSPIM. Pipette 

50 μl of poly-L-lysine onto a cleaned coverslip, by smearing it across the central region. 

After letting the solution dry for 5 min and pipetting off excess poly-L-lysine, add 50 μl of 

2,000×-diluted 100-nm yellow-green bead solution. Allow the beads to dry completely, and 

wash them two or three times with water. Coverslips can be stored indefinitely at room 

temperature.

Dye solution—Dye solution is useful to visualize the fluorescent emissions from the light 

sheets during diSPIM alignment. We usually start by diluting Alexa Fluor 488 streptavidin 

conjugate 1,000× in water (this solution can be stored at room temperature over a period of 

weeks), adjusting the concentration as necessary during imaging.

EQUIPMENT SETUP

Worm-pick creation—Worm picks for gathering and moving gravid C. elegans are made 

by inserting a 32–38-mm platinum wire into the thin end of a glass Pasteur pipette, so that 

roughly 20 mm of the wire protrudes from the pipette. The end of the pipette is briefly 

heated over an ethanol lamp to fuse the glass to the platinum wire. After fusing, pliers are 

used to flatten the end of the platinum wire, thus increasing the available surface area for 

picking worms. Note that this procedure is covered in great detail in Murray and Bao23.

Mounting coverslips into the imaging chamber—The samples in the following 

procedure need to be mounted on cleaned (as described previously24) rectangular coverslips 

that are then placed into the steel imaging chamber. This procedure usually takes 5–10 min, 
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9| Install the excitation laser launch. If you are using a commercial unit, determine 

how the laser lines can be controlled with analog voltages. Make the necessary 

electronic connections to provide analog voltages to the commercial laser launch 

from the DAQ cards. If you are using a home-built laser launch, control the 

lasers using the AOTF. Connect the AOTF controller to the DAQ cards with 

BNC cables. Verify that all laser lines can be shuttered and that their intensity 

can be varied using the AOTF controller.

! CAUTION To avoid serious injury when using lasers, always follow 

recommended safety procedures. We recommend the use of laser warning signs 

and safety equipment (such as laser goggles) in line with requirements set by 

institutional, local and national safety standards.

10| Connect and test the bottom camera using the manufacturer-supplied camera 

control software.

Setting up the diSPIM frame and installing the lower imaging path ● TIMING 4–6 h

11| Bolt the RAMM frame to the optical table.

12| Attach the bottom LS-50 stage.

13| Attach the mirror cube to the LS-50 stage.

14| Insert emission filters (488-nm long-pass and 561-nm notch filters) into the 

dichroic filter cube, and then attach the dichroic filter cube to the mirror cube.

15| Slide the tube lens through the bracket and lock it onto the dichroic filter cube.

16| Attach the bottom camera to the tube lens using the c-mount connection.

17| Attach the 10× objective to the objective adaptor on the LS-50 stage 



the stage. Make sure that the marked surface is facing up. Turn on the room 

lights and focus the bottom objective on the coverslip. Locate the black mark on 

the coverslip and position it in the center of the FOV of the bottom camera. 

Focus the bottom objective on the black mark using visual feedback from the 

camera (focusing at the edge of the mark may be easier than focusing in the 

center; use exposure time: 300 ms). Record the XY position of the stage and the 

position of the bottom objective displayed on the stage controller.

Aligning the excitation scanners ● TIMING 3–4 h

21| Connect the fiber output from the laser launch to each scanner. Turn on the 488-

nm laser output and project both beams onto a wall or board, which is at least 1 

m away from the scanner.

22| Ensure centration of beams on each MEMS mirror (Supplementary Fig. 1). If 

the beams are not centered, use the MEMS mirror adjusters (the four screws 

holding each MEMS mirror) to improve centration.

23| Once the beams are centered, open and close the iris and monitor the output 

beams. Close the iris so that the MEMS mirror boundary is not visible in the 

beam profile. (This ensures that the beam diameter is not bigger than the MEMS 

mirror.)

▲ CRITICAL STEP Do not close the iris completely, as this affects the light 

sheet thickness (Supplementary Table 1) and reduces excitation power.

24| Switch off the 488-nm laser, attach the tube lens to the scanner and mount both 

scanner assemblies on an optical table using tube lens brackets and posts 

(Supplementary Fig. 1). Switch on the 488-nm laser and examine the 

collimation of each beam. The beams should not markedly change their 

diameters (i.e., they should be well collimated) over a distance of at least 5 m, 

and they should emerge from the center of the tube lenses (using a circular target 

is helpful in checking centration after the tube lenses; Supplementary Fig. 1). If 

the beam diameter noticeably grows or shrinks over this distance, the beam 

collimation state must be adjusted by translating the position of the collimation 

mirror (Fig. 1d). Once both beams are collimated, remove the tube lens and 

check the centering of each beam on its MEMS mirror again (Step 22). If the 

beam is not centered, repeat Steps 22–24 and recheck the collimation. Repeat 

this process until both beams are well centered and collimated.

Assembling the optics in dichroic filter cube holders and attaching them to excitation 
scanners ● TIMING 1 h

25| Remove the top plate of the dichroic filter cube holder along with the dichroic 

filter cube (refer to Supplementary Note 1, SF5). Release the dichroic filter cube 

by loosening the screw on the top plate.

26| Open the dichroic filter cube and slide in the dichroic mirror.
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▲ CRITICAL STEP Make sure that the reflecting surface of the dichroic 

mirror faces the laser input. Do not overtighten the screws holding the dichroic 

mirror in place, as this will cause optical aberrations.

27| Insert the emission filters (488-nm long-pass and 561-nm notch filters) on the 

transmission side of each dichroic filter cube. Reattach the dichroic filter cube to 



38| Connect the Tiger controller inputs to the DAQ cards (BNC extension boards) 

using BNC cables, as described in Supplementary Note 2.

▲ CRITICAL STEP Unplug the power cable of the Tiger controller before 

connecting the inputs to the DAQ card.

39| Open ‘diSPIM Control.vi’ (Supplementary Note 2) and select parameter 

adjustment mode. Enter the following parameters: Time/Plane, 1,000; Z Step 

Size, 0; Planes/Volume, 0; Light Sheet Width, 0; no. of Volumes, 1; Time Point 

Delay, 0; SPIM arm A and B Z-Galvo offset, 2.5 V; Y-Galvo offset, 2.5 V; 

Objective offset, 5 V; Z-Galvo and Piezo Conversion factor, 0. Here ‘X, Y and Z 

‘ are local coordinates that refer to the individual excitation, defined in 

Supplementary Note 2.

40| Switch on the Tiger controller and run ‘diSPIM Control.vi’. This will bring the 

objective piezos to the center of their range by providing an offset voltage of 5 

V. It will also move the MEMS mirror to the zero position in both arms.

▲ CRITICAL STEP It is prudent to monitor the output of the piezos using an 

oscilloscope. Connect the ‘sensor out’ signal from the piezo card to the 

oscilloscope, and ensure that the sensor readout displayed on the oscilloscope 

matches the voltage applied to the piezo. If inconsistencies are observed, contact 

ASI.

41| Bring the diSPIM module down (toward the coverslip) using the stage controller 

and ensure that the objectives do not touch the coverslip.

▲ CRITICAL STEP Move the diSPIM module in small (~10 μm) steps to 

ensure that the objectives do not hit the side walls of the chamber.

42| Stop moving the diSPIM module toward the coverslip once the intersection of 

the two beams touches the coverslip surface (visual inspection is enough at this 

point).

43| If the intersection of beams is laterally offset from the black mark, adjust the 

position of the CDZ-1000 stage (Supplementary Note 1, SF9) until the beams 

intersect each other on the black mark. Record the F axis position from the stage 

controller.

44| Move the diSPIM module as far away from the coverslip as possible (~35 mm), 

remove the imaging chamber, replace the marked coverslip with a fluorescent 

bead sample and place the imaging chamber back in the diSPIM. Bring the 

diSPIM module toward the coverslip at the F axis position recorded in Step 43, 

r97oller.



46| If the spots do not overlap, attempt to bring them closer using the objective 

adjuster and by moving the diSPIM module toward or away from the coverslip 

(in 5–10-μm steps). Both spots should be as focused as possible, as viewed in 

the bottom camera, and they should overlap completely (as shown in 

Supplementary Fig. 2). Record the F axis position once the spots overlap and the 

focus has been optimized.

▲ CRITICAL STEP Do not attempt to focus by using the lower objective; the 

goal is to bring the spots to the focal position determined in Step 20.

47| Once the spots in the bottom camera overlap, refocus the bottom objective and 

compare their relative sizes (if the spots are very bright and saturate the camera 

pixels, reduce the laser power). If they are not of the same size, repeat Steps 33 

and 34 until the spots are equal in size (the difference should not be >20%).

48| Expect to iterate Steps 33–47 until the two spots are separated by no more than 

50 μm, as viewed in the bottom camera, and they appear to be of the same size. 

This might take several hours.

Assembling and positioning the SPIM cameras ● TIMING 4–5 h

49| Bring the diSPIM module to the F axis position recorded in Step 46.

50| Attach 65-mm spacer tubes to each dichroic filter cube holder (Supplementary 

Note 1, SF10).

51| Attach the mirror cube holders to the spacer tubes so that the circular opening in 

the cube points toward the back of the microscope.

52| Attach the tube lenses to the SPIM cameras.

53| Place the SPIM cameras in a horizontal position so that the bottom plate faces 

down, toward the optical table (the bottom plate of each Flash 4.0 camera has 

four threaded holes that are a convenient reference point, Supplementary Note 1, 

SF11).

54| Mount the tube lenses into the brackets and mount the brackets onto variable 

height posts (Supplementary Note 1, SF3; posts are assembled by screwing post 

holders to mounting posts (P4-1.5-inch to PH4)). Adjust the height of the posts 

until the top surface of the tube lens bracket is ~50 cm above the surface of the 

optical table.

55| Position the camera assemblies until the tube lens is in line with the mirror cube 

(Supplementary Note 1, SF6) and the separation between tube lens and mirror 

cube is ~ 3 mm. Bolt the camera assemblies to the optical table using clamping 

forks (PF175).

56| Slowly move the diSPIM module away from the coverslip (~5 mm), making 

sure that the mirror cubes do not touch the tube lenses.

57| Rotate the SPIM arm A camera (along with the tube lens) 45° clockwise and the 

SPIM arm B camera 45° counterclockwise (looking from the back of the 
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diSPIM system; Supplementary Note 1, SF11). Visual alignment as in 

Supplementary Note 1, SF11 is sufficient.

58| Bring the diSPIM module back to the position in Step 46.

59| Switch on both SPIM cameras and open the Hamamatsu HCIMG software. Set 

the exposure time to 100 ms, use the entire FOV (2,048 × 2,048 pixels) and set 

the cameras to ‘auto intensity’ mode. Switch on the 488-nm laser and block the 

laser input to arm B. Run ‘diSPIM Control.vi’ using the parameters entered in 

Step 39. Examine the fluorescence in the SPIM camera B: you should see a 

horizontal pencil beam (Supplementary Fig. 3). If the beam is substantially 

tilted, adjust the dichroic mirror of SPIM arm A until the beam is horizontal.

60| Unblock the laser input to arm B and you should see a new fluorescence spot 

caused by epifluorescence close to the pencil beam (in Step 59). If you do not 





FOV, as determined by the Y offset (defined in Supplementary Note 1, SF12). If 

the beams are not centered, adjust the mirror cube using the fine adjustment 

screws on the top plate of the mirror cube (Supplementary Note 1, SF10) until 

SPIM beams appear centered in both camera FOVs.

▲ CRITICAL STEP The Y offset is crucial because the Flash 4.0 camera 

acquires images in rolling shutter mode, and the speed of acquisition thus 

depends upon the location of the FOV in the camera chip. The value of Y offset 

depends on the region of interest (ROI) size. For example, for a 500 × 500 pixel 

FOV, the Y offset should be 774 pixels and the beam should appear in the 

middle of the FOV (~1,024 pixels; Supplementary Note 1, SF12).

72| Run ‘diSPIM Control.vi’ in parameter adjustment mode for 1,000 volumes using 

the parameters recorded in Step 70. As long as the .vi file is running, two 

vertical lines corresponding to the SPIM beam and epifluorescence beam should 

be visible in SPIM cameras.

73| Examine the vertical lines in the SPIM cameras using the HCIMG software, and 

record the X offset position. If the Y offset is lower or higher than 774 (for 

example, if using a 500 × 500 pixel FOV), adjust the beam position using the 

fine adjustment screws on the top plate of the mirror cube (Supplementary Note 

1, SF10).

74| Stop ‘diSPIM Control.vi’ and record all front panel parameters and SPIM 

camera offset values. Examine both beams using the bottom camera. Save an 

image that records the position of the beams in the bottom camera. Future 

samples should be moved using the XY stage until they are located at this beam 

position, thus ensuring that the light sheets excite the sample and that the sample 

lies in the FOV of both SPIM cameras.

Imaging a fluorescent bead layer to measure the PSF and beam thickness ● TIMING 1 d

75| Setting image acquisition parameters for optimal image quality (Steps 75–81). 

Place a coverslip with a fluorescent bead layer sample in the sample chamber. 

Fill the chamber with water and place it on the XY stage. Bring the diSPIM 

module close to the coverslip (F axis position used in Step 74).

76| Select the scouting mode in ‘diSPIM Control.vi’. Enter Z-Galvo offset, Y-Galvo 

offset and Piezo offset as specified in Step 74. Enter Time/Plane, 5 ms; Z Step 

Size, 0.5 μm; no. of Planes/Volume, 80; Light Sheet Width, 60 μm; no. of 

Volumes, 1; Time Point Delay, 0; GFP laser Intensity, 5; Z-Galvo Conversion 

factor, 0.013 V; Piezo Conversion factor, 0.05 V.

77| Acquire a single volume by running ‘diSPIM Control.vi’.

78| Open up both stacks of tiff images in ImageJ (i.e., corresponding to each view).

79| Examine the maximum intensity projection and individual planes in the volume. 

Ideally, the beads should appear as shown in Supplementary Figure 7 (middle) 



adjust the focus of the collection objectives as follows: set the Z-galvo 

conversion factor in the ‘diSPIM Control.vi’ to zero, ensuring that the light sheet 

is stationary (i.e., is not scanned in the Z direction). Acquire 1 volume. Examine 

the stack of tiff images by opening the stack in ImageJ; the image should go 

from out-of-focus to in focus, and then leave focus again (Supplementary Data 

3). Next, find the frame at which the beads are in best focus. If the collection 

objective is in focus, then this frame should be in the middle of the stack. If the 

focused frame number is more than half the total number of frames, reduce the 



85| Subtract the average background (background image taken in Step 83) from this 

stack (Process -> Image calculator).

86| Select a bead from this stack (draw a rectangle around the bead, ~14 pixels on a 

side) and duplicate it in ImageJ (Image → duplicate).

87| Clear the scale (Analyze → Set scale → click to remove scale).

88| Set the Z-scale to 3.07 (0.5/0.1625, i.e., the step size divided by the pixel size 

(Image → Scale)), so that the voxel size is isotropic (0.1625 μm in each 

dimension).

89| Reslice this image from the top (Image → Stack → Reslice).

90| Draw a horizontal line across the center of the bead, and measure the lateral 

intensity profile of the bead.

Draw a vertical line across the center of the bead and measure the axial intensity 

profile for the bead (Analyze → Plot profile). From these intensity profiles, 

record the full-width at half-maximum (FWHM) values in pixels and convert to 

μm by multiplying by 0.1625. These values should be close to 0.5 μm (lateral) 

and 1.7 μm (axial) (as in Fig. 2c, Supplementary Table 4 and Supplementary 

Data 5 (SPE6 



series of measurements described above, repeat the same procedure for the other 

SPIM arm. Example results are displayed in Figure 2 and Supplementary Note 

1, SF13. The expected light sheet thickness should be close to ~2 μm at the 

beam waist.

? TROUBLESHOOTING

Imaging cells or C. elegans embryos ● TIMING 1–5 d

96| Once the system is assembled and characterized, C. elegans embryos (option A) 

or cultured cells (option B) can be imaged.

(A) Imaging C. elegans embryos ● TIMING 4–14 h

i. Embryo isolation. Add 20 μl of 1% (wt/vol) methyl cellulose solution to a square 

watch glass.

ii. By using the dissecting scope to visualize worms, use the platinum wire worm pick 

to transfer 5–8 gravid adult C. elegans from the worm plate to the drop of methyl 

cellulose. The adult C. elegans should be seen swimming in the methyl cellulose 

solution.

iii. Locate a swimming adult and use the scalpel to slice the adult worm in half. 

Embryos should be seen to spill from the two halves of the adult C. elegans.

iv. Transferring embryos to the well chamber. Place a coverslip into the imaging 

chamber and pipette 30–40 μl of poly-L-lysine into the center of the coverslip. Wait 

for ~5 min, and then fill up the chamber with fresh M9 buffer (7–8 ml; 

Supplementary Note 1, SF14).

v. Insert the capillary into one end of the aspirator tube (Equipment Setup). Insert a 

clean 20–200-μl plastic pipette tip into the other end of the aspirator tube. Make 

sure that only the clean 20–200-μl pipette tip enters the mouth when using the 

aspirator tube.

vi. Place the capillary into the methyl cellulose solution and gently suck several 

embryos into the capillary via gentle pressure.

vii. Transfer the tip of the capillary into the imaging chamber. Position the capillary tip 

so that embryos will fall into the central square of the coverslip.

viii.  from the 30–40 �coze wgare of the coverslip.

viii.
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? TROUBLESHOOTING

xxiii.Run ‘diSPIM Control.vi’ in Image Acquisition Mode (GFP, 488 nm) with the 

following parameters for 14-h imaging: number of Volumes, 1,000; Time Point 

Delay, 60 s, and provide a file name. Note that we assume that imaging commences 

when the embryo is in the 4–8-cell stage.

xxiv.Process the images according to the instructions in Steps 97–106. Figure 3 shows 

selected maximum intensity projections from the deconvolved data set (see 

Supplementary Data 7 for data relating to this figure); see also Supplementary Data 

1.

(B) Imaging cells ● TIMING 4–5 d

i. Preparing the coverslips for cellular imaging. Place rectangular glass coverslips in 

a glass beaker half-filled with distilled water, taking care to separate coverslips that 

are stuck together. Boil them for 10 min. Let the solution cool and occasionally 

agitate.

ii. Rinse the coverslips extensively with distilled water.

iii. Transfer the coverslips to a clean glass beaker with 1 M HCl solution. Place them 

in a fume hood and allow them to stand overnight.

iv. The next day, rinse them extensively with distilled water.

▲ CRITICAL STEP

iv.



ix. Pipette 500 μl of plain DMEM in a sterile 1.5-ml tube. Add 5-10 μg of plasmid 

DNA (GFP-tagged H-Ras), and mix it well but gently.

▲ CRITICAL STEP Plasmid DNA should be of high purity to increase 

transfection efficiency and to minimize toxicity.

x. Add TurboFect liposomes reagent at a 2:1 or 3:1 liposome:DNA ratio and mix four 

or five times gently. Let it stand for 15–20 min.

xi. Distribute the transfection mix to the cells dropwise using a 1-ml pipette (the broad 

tip reduces the disruption of lipid-DNA complexes).

xii. Return the cells to the incubator (37 °C, 5% CO2) overnight.

xiii. Cellular imaging. On the next day, insp psFukT2igeF0 10 Tf 71.12
plls1of 1 0



volumes and time delay between volumes on the basis of your requirements (for the 

data in Fig. 4 and Supplementary Data 8, the number of volumes was 350 and the 

time delay 5 s).

xxv.Process the acquired images as described in Steps 97–106 below.

Data processing ● TIMING 3–8 h

97| The data files output from each SPIM camera should be in multipage TIFF 

format—i.e., each TIFF file should contain an entire volume represented as a 

stack of individual planes (images). Separate all volume files into two folders, 

corresponding to the two SPIM cameras, as shown in Supplementary Note 1, 

SF16.

98|

http://mipav.cit.nih.gov/download.php
http://mipav.cit.nih.gov/pubwiki/index.php/Installing_mipav
http://mipav.cit.nih.gov/pubwiki/index.php/Installing_mipav
http://mipav.cit.nih.gov/pubwiki/index.php/Allocating_Memory_in_MIPAV
http://mipav.cit.nih.gov/pubwiki/index.php/Allocating_Memory_in_MIPAV


registration. If the sample does not move much during imaging, an early time 

point can be used to generate a registration matrix that is applicable to the entire 

time course. In such cases, we usually choose one of the first 20 time points for 

matrix generation. In samples in which substantial movement occurs during 

imaging, it is necessary to process the data in subgroups (we have found that 

subgroups consisting of ~100 time points work well), or even run registrations at 

each time point in the series by choosing ‘All time registration’. In the latter 

case, users will only need to specify the directory in which to save the matrix for 

each time point.

103| After setting the registration parameters, define the range of angles used when 

transforming volume B into volume A via the registration procedure. Typically, 

a searching angle range from −10° to 10°, a coarse angle increment of 2°–3° and 

a fine-angle increment of 0.5°–1° results in an acceptable registration within 5–

10 min.

104| Specify where the raw data are located (Supplementary Note 1, SF18). Images 

placed in the ‘transform’ directory will be rotated by 90° about the Y axis (as 

illustrated in Supplementary Note 1, SF19), transforming them into the 

coordinate system of the images inside the ‘base’ directory. Also specify the 

range of volumes that need to be transformed, fused and deconvolved. If this 

range is left empty, the plug-in will automatically select all volumes.

105| Set parameters in the ‘Option’ tab (Supplementary Note 1, SF20), including 

pixel size and the number of concurrent fusions to run (at most, the number of 

CPU cores on the machine). Users also need to set other options by selecting the 

‘Options’ tab in the plug-in, as shown in Supplementary Note 1, SF20. In the 

‘algorithm options’ (red box), set the image pixel size and the number of 

concurrent fusions, which depend on the number of CPU cores (e.g., users can 

input up to 12 if the computer has 12 CPU cores). If desired, specify whether to 

display or to save intermediate processing steps, such as maximum intensity 

projections or fusions based on the arithmetic or geometric mean between the 

two views. Finally, set the GPU-based deconvolution parameters including 

iteration number (at least 10), sigma values (in pixels) of the PSF characterizing 

each view (typically 3.5, 3.5 and 9.6 for X





• An example of raw cellular data acquired from each arm and the resulting 

deconvolution (corresponding to Fig. 4 and Supplementary Data 8)

Supplementary Material

Refer to Web version on PubMed Central for supplementary material.
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Figure 1. 
DiSPIM with major subassemblies. (a) Perspective view of assembled diSPIM, with 

microscope frame, inverted microscope components, cameras and major diSPIM 

subassemblies indicated. ‘DiSPIM module’ refers to scanners, dichroic filter cubes, tube 

lenses, objectives, piezos and associated optomechanics that move as a single unit on an 

LS-50 translation stage. Refer to the MATERIALS section for further description of 

component parts. (b) Photograph to accompany a. (c) Higher-magnification view of 

excitation and detection subassemblies in the diSPIM module. Excitation (blue) and 

emission (red) along a single arm of the module are highlighted. (d) Detailed view of the 

excitation scanner, showing fiber input, mirrors and relay lenses. (e) Higher-magnification 

view of objectives, piezos and holders/adjusters. (



Figure 2. 
Verifying system performance. (a) Measuring the system PSF across the FOV by collecting 

a Z stack on a fluorescent bead. Light sheet and the collection objective move in sync. (b) 

XY maximum intensity projections of beads, showing raw data from view A (left) and view 

B (right). Scale bar, 5 μm. (c) Higher-magnification view of beads within dashed rectangular 

region in b, highlighting the improvement in lateral and axial resolution after joint 

deconvolution procedure. Scale bar, 3 μm. See also Supplementary Table 4 with lateral and 

axial resolution from all beads marked with red circles in b. (d) Measuring the light sheet 

thickness. The collection objective remains focused on the fluorescent bead, integrating the 

fluorescence as the light sheet is scanned through the bead. (e) Light sheet thicknesses in 

arm A (blue diamonds) and arm B (red squares). Apparent light sheet thicknesses at this 

location are 2.1 μm (SPIM A) and 1.8 μm (SPIM B). Data were derived from the bead 

marked with the blue squares in b. See also Supplementary Note 1, SF13, showing the light 

sheet thickness measured at different locations across the FOV. Note that schematics a and d 
are not to scale; dimensions have been altered to improve image clarity. See also 

Supplementary Data 2–5.
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TABLE 1

Troubleshooting table.

Step Problem Possible reason Solution

29 Beams are not intersecting Scanner is not mounted properly Remount the scanner and recheck beam 
intersection

Dichroic mirror is not placed 
properly

Adjust the dichroic filter cube using fine 
alignment screws (shown in SF5 in 
Supplementary Note 1) until the beams 
intersect

60 Epifluorescence spot is not close to the 
pencil beam

Objectives are not focused at same 
spot

Adjust the position of the objectives coarsely 
(as in Step 46) until both focus at the same spot

Y offset of the MEMS mirror (Y-
galvo offset) is not optimal

Change the Y offset of the MEMS mirror 
(either arm or both arms) to bring the 
epifluorescence spot closer to the pencil beam

63 In the SPIM camera, only one line is 
visible

This signifies that both objectives 
are co-focused and well aligned

To test alignment, move the diSPIM module up 
or down (5–10 μm); two lines should be visible

65 Light sheet is tilted (shown in 
Supplementary Fig. 4)

Scanner does not make a 45° angle 
with respect to the optical table

Rotate the scanner that is creating the light 
sheet so that lines appear vertical in the bottom 
camera

80 Maximum intensity projection of beads 
image is blurry

Collection objective is not focused Change the collection piezo offset

Light sheet and collection 
objectives are not synchronized

Change the Z-galvo conversion factor

Z-galvo offset is not optimal Change the Z-galvo offset

Light sheet is thicker than it should 
be

Measure the light sheet thickness

Beads in the sample are aggregated
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Step Problem Possible reason Solution

Registration is not optimal Check the transformed image and make sure 
that registration is good (examples are shown in 
Supplementary Note 1, SF1). Also consider 
breaking up the registration as described in 
Step 102

X, Y, Z resolution parameters 
entered into processing software are 
incorrect

Check the X, Y and Z resolution parameters 
entered in MIPAV

Deconvolution parameters are 
wrong

Check the deconvolution parameters in MIPAV
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